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4 Chapter 2 — Schematic Capture Editor

Chapter 1. Getting Started

Introduction to Easy-PC

Welcome to the Easy-PC Schematic and PCB design system. The system is built on an
integrated design environment providing all the tools required to capture a schematic and
simulate it using the SPICE based analogue/digital simulator, through to the design and layout
of the printed circuit boards (PCBs). This is aided with a shape-based autorouter and various
options.

System Requirements

Easy-PC runs under the Windows operating systems but it is recommended that Windows 10
or 11 is used. It cannot run under Windows systems older than Windows 8.1, Linux or MAC.
An i5, i7 or i9 processor with plenty of memory installed should be used. Easy-PC does not
require particularly ‘high-powered’ hardware to achieve good performance, a regular off-the-
shelf PC should be sufficient. A complete product installation requires at least 390Mb of hard
drive space. A mouse with a mouse wheel is recommended and an internet connection is
required to load the product from our web site.

Installation

It is assumed that you have successfully installed the Easy-PC product or demo onto your
computer. If you haven't, then use the trial or product download from the numberone.com
web site. The installation is straight forward using the wizard provided. Follow the instructions
and use the default settings provided. The tutorial designs can be run even using Easy-PC in
demo mode if the demonstration version is being used. Note, the demo version and full
product are not the same, the demo cannot be ‘converted’ to a full version, it requires a new
installation.

Introduction to the Tutorial

You can quickly familiarise yourself with the Easy-PC features available and its design
methodology by working your way through this tutorial and using the Online Help for more
detail. This tutorial is broken down into logical sections following a typical Schematic to PCB
design cycle.

The Schematic design editor is used to capture your logical design and ‘drive’ the PCB design.
However, the PCB design editor can be used with or without the schematic design as you
wish.

An important aspect of the PCB design is the production of professional manufacturing data,
and hence the final PCB. Easy-PC has outputs to Gerber 274-D and 274-X (with the embedded
apertures), NC Drill, pen plotter, full Windows printer support, ODB++, Bill-of-materials,
netlists, DXF and IDF formats. Assembly machine outputs for pick & place machines etc. can
also be output.

Additional Help and Information

There are many more exciting aspects to Easy-PC which are not covered in this document.
Further information can be obtained in the Online Help by pressing the <F1> key on your
keyboard at any time, or by reading the Easy-PC Users Guide. A paper ‘book’ version of this is
supplied when the product is purchased. You can also obtain additional information by
emailing us at support@numberone.com or by calling us or your local Easy-PC distributor.

Removing the Software

If for any reason you need to remove Easy-PC from your computer, you should do this by
selecting the Add/Remove Programs icon from the Control Panel on the Start menu.
Select Easy-PC version xx from the list of installed programs and click the
Change/Remove button.
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Starting Easy-PC

During installation, an Easy-PC program group added to the Start menu,
under Programs then Number One Systems.

To start Easy-PC, simply select the Easy-PC menu item.
Y Py Y Easy-PC

The Easy-PC Desktop

When you run Easy-PC, the main application window appears. You can open any number and
combination of different designs and libraries together in this. Easy-PC is broken down into
many facets as are most Windows applications. The picture below shows you the major
framework facets by name so that as they are used in this tutorial you will understand what is
being talked about.

Menu bar Sub-menu Find Browser
Menu World View
‘ Docked toolbar ‘
|

Sliding Browsers

4] Easy[ PC by Numbgr One Systems - [interface.sch (Schematif Design)] (=R
s w| Add Settngs Output Smubion Took Window Hel 5
0 & & & % Display... Shit+F o =5 = A= S o g
o B xr.. = = =
% T |l g B, Component... J|1110000 1 11000 1 12000 1 16000 1 14000 1 15000 1 16000 | 17000 1 180K Goto St
I [ soto My e World View| x * | eomemn 28
o I 4 o | cz N =
Kz Highlight Net 3 Relative Origin...  Shift+0 [y o =
A= o e Selection Orign  Shift+H S g
Ei = System Origin ot o
- & unzoom = PL1a
3 % Frame Ctrl+F |#m Previous Error v 3 T |{PLEe
= - o £l PL2a
3 B & Al A |fon Next Error o \”H”H FLZb L™
[} Selection Remave Highlight M e ES E
Q|| < Refresh amR (77 AL E
interface.pcb (PCE Design) * El
o e — % r\; 23] interface.peb (1 esign) - s
= (l= ] a2 3
2 ™ Toolars... = Rl ES
- Status Bar 0H R2
= [H start Page L Ej
RepOrt Browser... e A5
= Dockable Bars 3 {] RE
S ild
= [ Tabbed Desians i | i o
D ;
He, A9 i
3 I
_ [ meuelrtlei.. 1 Gl
AR 2| - RiZa
= —‘ GIES
s = — t Alze
U:ﬂﬂ]ﬂ LT M| A1zd
. — _./ﬂ,'% b s
2 o
4 i v
O i b
[Blinterface.sch| 3] inigrface.pch
jpbsfs341.62 $a489.24thou

Workbook 'mode' PCB Window Status bar

Design window
(maximised)
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Toolbars

Easy-PC is installed with a set of commonly used toolbars for you to use. These tools can be
fully customised to suit your own design practice once you become familiar with the product.

& Easy-PC by Number One Systems - [Div (PCB Design}] = =
34| Fle Edit View Add Setings Ouput Tools Window Help _os
O o @ (0 6 # o
- RONCRPNEEY . T _HR [GRE
%% shVA BAAQRE S+L 2 FEEE =D 0D ® & .
[ I 200 1 [400 1 OO0 1 BDO 1 1000 1 1200 | 1400 | 1600 1 1800 | 2000 o5

~

B

If you hover the mouse over the toolbar buttons a small tooltip
is displayed showing the button function and its keyboard
s shortcut if one has been defined.

| Add Component (F8) |
el |

Customising Easy-PC

Easy-PC provides you with the ability to customise the user interface with your own Toolbars,
menus and keyboard commands. You also have a complete command set of all the options
within Easy-PC which can be assigned to a shortcut key on the keyboard. Other aspects of
Easy-PC can be customised using the Customise option on the Settings menu.

Commands and Shortcuts

As well as the toolbars, Easy-PC has the ability for you to programme your keyboard for
commonly used options or commands. This means that once programmed, you can press a
key or key combinations to enter a function or option. For experienced users, this makes the
program's operation far more efficient.

When Easy-PC is first installed, you will find a set of shortcuts already defined for you. These
are only a default set and can be modified to your own preference through the Keyboard tab
on the Customise dialog. AlImost all of the keys on a standard keyboard can be utilised giving
you extensive coverage.

A full report of all the assigned keys can be obtained from this dialog using the Shortcut
Report button on the Keyboard tab.

Cancelling Commands

All dialogs and commands can be exited at any time by clicking the ESC key on the keyboard.
Sometimes this will need to be clicked a couple of times if you are ‘down’ in a sub-menu or
lower-level option.

Units

The Units option on the Settings menu is used to define the units and the precision at which
the co-ordinates and lengths displayed in the dialogs and edited by you are displayed. The
basic working units can be changed between Imperial and Metric design units. You can
quickly toggle between Metric and Imperial units by using the Switch Units button on this
dialog or by clicking the shortcut Shift-I when working in the design.

Units The design units are stored in an internal
database with a precision of 1/100 micron
Current Units regardless of what the unit precision is set
e reg P
Precizion: |0 = Cancel
For each type of units, you can specify a
Altemate Urits — precision. This is the number of decimal
T e ™ il Uil places displayed; the value is simply

rounded to the nearest last digit.

Frecision: |2
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Grids

Grids are used in Easy-PC for defining the points or steps that items will snap to when they
are placed and for visible references in the design. For this, the Grids dialog on the Settings
menu can contain any number of named grids:

Grids
Grids
0.5mm Add...
Carnieel
Polar Grid 50 thou Rename... . ) ]
= Working Gid - The Grids area will allow you to define
S0P the grid used for placement of design
Delete items during manual interaction.

Make Current

[ &ids visible only Draw Current Grid

==y M S E Grids can be defined as regular X Y grids

th . -
25.2000 o or polar (radial) grids.

[ pifferent v: 25.0000

Qrigin )

[¥] Follows Design Coordinate Origin They can be referenced relative to the
0.0000 Coordinate Origin.
0.0000

Snap

Snap Mode: Grid Y]

Display The Visible check box enables the grids

[#]visible  []Draw Grid First  [_] Draw Crosses to be displayed on or off, this can be set

Primary Colour: o v [Lines at any time in the design using the

[ Secondary Colour: | [N (v [ Lines shortcut key <G>.

The Display area is used to define the
display of 'dots' or ‘line’ to guide you
while designing. Size Steps: is used to
define the ‘pitch’ of the grid and uses the
Secondary Colour to display them. The
Primary Colour is used to display
another grid based on a 10 times larger
size than the Secondary Grid.

Snapping to Grid

The Snap Mode shortcut can be displayed during editing by selecting the direct keyboard
command <H>. By selecting the snap mode setting you can use predefined multiples of the
Working Grid to move items for example.

Grid

Half Grid
Quarter Grid
Tenth Grid
Fortieth Grid

[«] [x]

25 thou
Metric 0.5mm
Polar 25 thou
Screen Grid
Working Grid

H Grids...
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Shortcut Menus

The right hand mouse button can be used extensively throughout Easy-PC to display shortcut
menus, these are also known as context menus. These menus can be accessed during an
operation and contain a set of relevant 'context' commands.

Once familiar with the system, you can access the shortcut menus by right clicking directly on
the item and picking the option from the menu.

T online DRC
Enable Nudge
& Fix Item
[ Romt= v Angle 0
Flip F | Angleso
Ba Duplicate D Angle 180
C4 85 Replicate... Angle 270
Edit Component In Library... Rotate One Step R
] [ Edit Symbol In Library... Rotate Step Back  Alt+R :I_
fﬂ Update Component.. Rotate By
Auto Weld Now =1
Save To Library...
Move to Component Bin ] [
Disconnect From Net
- ' C3

Undo/Redo

Easy-PC contains unlimited multi-level Undo and Redo capabilities for use through the
product. These are invoked using the standard Windows shortcut keys Ctrl-Z and Ctrl-Y
respectively, these are also available on the Edit menu and as toolbar icons.

Properties of items

Each item in the design contains a set of characteristics that can be viewed or edited using
the Properties option. Some items within the design are made up of several entities, each of
which is individually selectable and has its own properties that can be viewed, components for

example.

Properties - Component Pad

Pad

Mumber: | 2

Component  Walues Mets

Azsociated Parts Met

| Name: | B

[ Testland

Angle;

Plane Connection:

[]Pad Style Exception

[ sl Rreposition

Default Connection

w

Swle |3 |
Widhe (80,0000 | Shape:
Length: 110.0000 | Hole Size: |0.0000 Flated
0.0000 0.0000
Thermal:  |0.0000
Layer. [[Top)
Fit M amne Fit Murnber
Cancel Apply Help

Design item properties can be viewed by

selecting the item and clicking on the
Properties option from the shortcut
menu. It is quicker though to select the
item and click the shortcut key Alt-Enter.
The example left shows the Pad properties

of a component pad.
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Status Bar

The status bar at the bottom of the design window displays useful information about the
design item selected. When using an option, like track editing, it also provides you with a
command prompt to show you what action is expected. More detailed information is also
available by selecting the design item and using the Properties dialog (shortcut Alt-Enter).

| < >

o DV - 2| Div 5 5

Component Pad||U3.1||Name: Y0||Style: Oval (60 x 110)| Size: Oval 60.0x110.0/|Pos: 1350.0,2500.0| Layer: [All]| Abs | 1374.5315||2494.6417 | |[thou

Design tooltips

As well as the status bar information and Properties dialog, by hovering the mouse over a
design item, information about that item will be instantly revealed on a design tooltip.

| m—
C1-2
Met: OUTPUT

o Layer: [Al]
Ay

Dockable Windows and Browsers

As part of the design suite, you have a number of dockable windows and browsers that can be
used. Each individual window can be specified to Allow Docking (enabled through the
shortcut menu for each window or browser).

—Hyl

Goto *ox
Component [By Type] W

2NT1
2M22224

SIBAET 0 | e

74L5244
74L5281
4724
E464t
BC134L
C

CP3
EURD

R

RaC
SFOT

ﬂ
=
&
o
Eoy
M
ulg uauodwon [Fu

Juauodwon ppy g‘

|

e Filter[_| 57 ":J ﬂ ﬁ
19.9803 ||1750.0079 |thou

These windows are available through the View menu Dockable Bars >

=¥ Refresh Ctrl+=R
'? Rulers...

™ Toolbars...

Status Bar

m Start Page

Repaort Browser...

Dockable Bars D‘ | World View
Tabbed Designs '% Add Component
Eﬁ‘ Properties... | Component Bin Ctrl+F9

Side 3 2| Layers

_I-|. Mets

B Colour Files

#4 Goto Bar

|'|; Shape Information
[C] Motes

5 Properties Bar
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Chapter 2. Creating The Schematic

Schematic Design Tutorial

During the tutorial we will create a Schematic design, this is how the engineer ‘conceived’ it:

+HSV +isV
j 'I' ” AD B¢ AN
oX TtV
z I ca ¢ ~-ISV
oV Malex comedor
Bn (0-lb-10$)
Vie 4? \Vou
Y J_. 1-b4
i 8n
it won
3 ov
ov
oV

Obviously, once the sketch has been drawn properly as a Easy-PC Schematic it will look quite
a bit different.

Starting a New Schematic

» To start a new Schematic design
On the File menu, click New and Schematic Design from the Design tab.
Mew e
Desion ‘wizard Technology

PCE Design

L —

Component
Praject
Panel Design

Using Technology File
|Default ) @

Add To Project

Browse...

Under Using Technology File, for the Name: click on the small 'down' arrow to reveal the
drop down list, select Default.stf

More detail about Technology files is available in the Online Help.

Click the OK button to start a new Schematic design.
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Your Easy-PC window will look like this:

E5] Easy-PC by Number One Systems - [Design1 (Schematic Design) *] = B
Fle Edit View Add Settings Output Simulation Tools Window Help -8 x
Do g 0. @ G PR &EE OB ) 5
% [ 20000 1 20500 1 21000 21500 1 [ 22000 | 22500 1 23000 1 23500 240 | 8

~ o

Ia E
5 |- :
A 2
%12 5
&

“a|l- ®
[ Z

= &

@1z g
B g
- El
w2

g E
z
— B
= &
o
S
2
o
=1
=1
&
o
g
S
- w
< >
[&E]1..., [ Design1] s x

Abs||[21880.21 ||19817.80 |thou

For now, we will progress on to adding components to the design.

Adding Components

You can use two methods to add components; by using the Add Component option and
using the Add Component Browser. For this tutorial, we will use the Add Component
Browser.

» To add a Component

The Add Component Browser bar has automatically been run when you started a new
Schematic design.

Hover your cursor over the Add Component Browser

-8 X

io E
23500 1 240 a
Ao

=1

__S'

3

o

=

En

3

uauodwos ppy g‘
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The browser will ‘slide’ out:

' Add Component r hx
dhc

TAHC02
T4HCO3
TAHC04
T4HC03
TAHC10 v

DIL v

1ayvee
‘D*
TRND

REE L
[«

[ sajon @] [ Wauodwon ppy @ [ uig Juauodwon m]

From the list of Libraries (which will show <None> or the currently selected library), select the
small ‘down’ arrow to reveal the full list of libraries.

From the list, choose Discrete

_Md Component &
Tahe (@

[All Libraries]
C:\Users\Public\Decuments\Easy-P(
User
Ch\Users\Public\Documents\Easy-P(
T4he
Tahct

T4ls

4000
Connector

[@

Hyhbrid
Opamps

-

The Component list will now be populated with components from that library. The first
component found in the library will be automatically displayed.

Add Component v aXx
Discrete

NPNTRAM
PFET
PMOS
PNPTRAN
PRESET

DsC v

R3
Q —O

»_sF

LK

From the list, select the component R. Either scroll down
using the slider bar or pick in the list and type R, the list
will then automatically scroll down to the first component
starting with the letter R.

This is a generic resistor which we will change the Value for
later on.

A preview of both the Schematic and PCB symbols is displayed.
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Once you have the correct component, you can add it to the design by selecting either of the
symbol previews and dragging it into the design. You can also add it by selecting its name (R)
and dragging it into the design.

This is a one-shot process. If you wish to add more components you must drag them from the
bin or copy an existing one in the design.

The component is currently on the end of your cursor. To place it in the design, click the left
mouse button once.

You need three resistors in total for the final circuit. Once the first one has been placed you
can copy it two more times. Select the resistor R1 in the design. Hold down the Ctrl key on
your keyboard at the same time as ‘dragging’ the mouse away from the resistor. As you
drag you will see that an identical copy of R1 has been made and is named R2.

Copy the resistor one more time to add a total of three.

Position them to look like this:

o R

R1
1K

» To pan & zoom in the design

To view the resistor closer, roll the mouse wheel button forward to zoom in. If you zoom in
too fast (and too far), roll the mouse wheel button backwards (slowly). If you zoom too far
either way, press A on the keyboard to View All and then zoom in again. Shortcut keys are
also available for Zoon in and Zoom out.

Microsoft (R) Intellimouse
(recommended)

Wheel rolled backwards
= Zoam Out

Wheel pressed dovwn and
released = Single Pan
Wheel pres=zed down and
heldd wehile moving mouse
= Dymanic Pan

Wheel rolled forwards
= Foom In

» To add the capacitors

We need four capacitors for this circuit. From the Add Component Browser option type C in
the list. The component name will jump back to the C component from the list.
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Add Component - B X

Discrete w
-

CP

CP-5M

CcP1

CP3

CP4 w

DsC w

C1

Pick and drag one component from the browser to the design to add it.
-
1K cr .
Le@anF

Just the one capacitor will be added.
We will use a different technique to add more capacitors.
Select the capacitor C1 in the design.

The standard Windows commands of Ctrl-C (Copy) and Ctrl-V (Paste) can be used to add
components by copying them. You can also use the Easy-PC command Duplicate <D> to
make copies.

Select C1 and press Ctrl-C to copy it. Now press Ctrl-V to paste a copy (now called C2) back
into the design.

= ﬁx{m}xﬁ

LeenF

Because the capacitor is in the paste buffer, you can add more of the same capacitor.

Move C2 away just underneath C1 by moving the mouse. Single click to release. Now do the
same again, this time to C2 to add another capacitor C3 and then again to C3 to add C4.

Your design now looks like this:
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R SR |
1K clt
A : 1eanF
e S |
R2
1K : cz
LeanF
e I |
R3
1K . c3
1BanF
— =
c4
LeanF

» To switch off the displayed grid

At this stage we don't really need to see the displayed grid dots so let’s switch them off. Click
<G> to toggle the grid off. Press this key again will switch it back on at any time.

» To add the Op-Amp

We will now add an Op-Amp. This time, click the Add Component button on the toolbar,
shortcut <F8>.

#
Fle Edit View Add ¢
D@ (0 &

{4400 1 4500 1 4600 1 470C
=
4dd Component (F8) h

ﬁ-'m
{%_
s

e

The Add Component dialog will display the 74HC.cml library, this is the first library selected.
We need to swap libraries to another one. Click the small ‘down’ arrow to reveal the fully
libraries listing.

Add Component
Library:
( |“>
[&1l Libraries]
[Current Design] ’

From the list, select the Opamps library.
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Add Component “
Library:
74 |v
[l Libraries]
[Current Design]
C:\Uzers' PublichDocumentshE asy-PChU serLib
Uszer
C:4U zersh PublichD ocumentshE asy-PCALibrary
Tdhc
Tdhct
7lz
4000
Connectar
Csm
Discrete
Dsm
HEb'id
Pch
Obsm
Gosm
Qsm
relay
Schema
Sm
Trarsistar
ore
i | o o
In the Component: list, type in AD844, this will jump down to the name AD844AN on the
list.
Add Component “
Library:
Opampz Y]
Companent: |5 Eind... Add
Count: Cancel
[ Filter
Mame: Apply
Fins: Clear
Package: DIPS W
Fief Mame: | )1
[ Previen v | [ Add ta Component Bin -~ 1
Lia
ADBE 44 AN
: - [+ ] o
o o
o L *
o o
1
o Jaes
Vi ADE 44 AN

This time we will place the component into the Component Bin and not directly into the
design to show you another mechanism for adding components to the design.

Check the Add to Component Bin check box on the dialog and ensure Count: is set
to 1. Click the Add button once then click the Close button to exit this option.

Before adding it to the design, roll the mouse wheel to zoom out. You will need to give
yourself some space on the design in which to place this new component.

To display the contents of the Component Bin, move your cursor to the right side of the Easy-
PC window over the Component Bin tab. Hover the cursor to reveal the Bin. Moving the
cursor away will slide the window back in to close it.
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Component Bin - BX
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Our Op-Amp (U1) is shown in the Bin as two gates (Gate a & Gate b). Click on Gate a under
the word U1 — AD844AN {DIP8} to see a preview of the symbol above it.

Select Gate a and drag it into the design (pick and drag at the same time). Position it near
the capacitors. Now go back to the Component Bin (hover the cursor over the Component Bin
tab). Drag Gate b from the bin. This is the Op-Amp power gate. Drag it into the design, it can
go anywhere and can be moved later on.

Your design should look something like this:

Ula
ADS 4 4 AN

e TR |
Rl 2 S
1K c1 VI3

Leenr
o IR 9
R2
1K cz Ulb

teenrF AD8 4 4 AN
A b

v

F3 7
1K c3 H— V'

teenr

o b

c4

teenrF

Before we add the connections, we should change the component values to be the ones
required. This is easy to do because we’ve used ‘generic’ components. If you prefer to use
specific Parts, you can also work this way with Easy-PC.
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» To edit component Values

Double-click on the Value field (1K) and the Text tab of the Properties dialog is displayed.
Click on the Component Values tab.

Properties - Value Position - Values

: E E : Text | Component | Values | Nets | Associated Parts | Net
R1
| K 2660000 | [IRel
Alignment: | Left W
Show
[ Reference Name
F_z_2/ []Component Name
¢ Y [_]Package Name
S [[]Symbol Name
[] Description
[+ Values
R3
1 K
Cancel HApply Help

The Value field shows the current 1K value and is already highlighted blue. Simply click the
Edit button or double-click the blue highlighted field to edit the value required. Type in 11K.

Properties - Value Position - Values

Text | Component | Values | Nets | Associated Parts | Net

When done, click the OK button to exit this dialog and OK again to exit Properties. When the
value of R2 is changed to 11K the design is updated.

Using the same process (double-clicking on the Value name), edit the Value fields for all R’s
and C's in the design as shown below:

R1 1K R2 11K R3 1.6K
C168n C2200n C3 0.22u C4 0.22u

Our design now looks like this:
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Ula
ADE4 4 AN

S | eI
R1 pe E 3 2
1k E.Cén w2 + L

Rz
11K

£2 Uik
2edn ADB44AN
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@. 22uF
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@. 22uF

If you select the whole component by mistake, you can still edit the Value field by clicking
Component Values tab on the Properties dialog.

» To save the design

At this stage it might be a good idea to save your design. If you are using the evaluation
tutorial with Easy-PC in demo mode, you will not be able to save the design. If you have
installed the purchased product, go to the File menu and Save As. Save it somewhere you
can find it later on if needed and call it something sensible, like Tutorial.sch.

Placing Components

The position of the components currently is as they were placed after adding them to the
design. We need to place them around the Op-Amp so they can be used in our circuit. On a
real design, this would be how you would work in practice. To remind you, the original ‘drawn’
circuit looks like this:

HSV +isV
I ’ AD B4 AN
(o I IV
z I W tf-lg\/
oV Malex comnedor
v lo-lb-10%|
Vie o0—1
o Vo
-6V
L(-
3
o=

ov

As before, move the components into position by picking and dragging them in one move
using the mouse.

Components can be rotated during move by clicking the R key (while using pick-drag). A
single click of the R key will rotate the component by 90 degrees. Click R more than once to
rotate it by another 90 degrees and so on.

You can also change the placement to fine tune it after adding the connections as well.
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The design will now be looking like this:

Cc3
@. 22uF

ADB 4 4 AN
e
RL e—8 [}
LK 3 + 1 v
¥ i -—<aC) 0
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T Qe -
Ulb
AD8B 44 AN
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oV e
~N &
(SN
C+
@. 22uF

You are now ready to add connections.

Adding Connections

Connections are added to the Schematic design to make connectivity between electrical pins.
When translated to the PCB design, these connections give you your net list.

By adding a connection when you start this tutorial, default properties are already set up. All
you need to do is add the connection. Later on, as you become more familiar with Easy-PC,
you can change and customise the connection properties to your own settings.

You can add connections in a number of ways:

e Using the Add Connection option from the Add menu or from the Schematic
Toolbar, click on the pin to start adding a connection, or;

e Double-clicking on a component pin to start a new connection, or;
e 'Dragging' off an unconnected component pin to start a new connection.

For this tutorial we will use the ‘dragging off pins’ method as this is the easiest to start with.

» To add connections by dragging off pins

To aid the addition of connections to a schematic, you can simply ‘drag’ off an electrical pin.
Each click of the mouse will then add a corner, moving over another electrical pin will show a
finish marker; a small illuminated blob over the pin. This shows the item as a legal landing
site to finish the connection.

Using the design that you have created so far, zoom in on the area around R1 like the picture
below.

x%_i_ + 1

When you hover the mouse over the right-hand terminal of the resistor R1 a small design
tooltip label is displayed. This confirms the name of the device and the pin number (R1-2).
Although on this resistor it is a bit excessive, on a BGA pin which has a connection and net
name, it becomes very useful (and essential!). These design tooltips are available for all
design items, not just pins.

Click and drag (keeping the mouse button pressed down) off pin 2 of R1, this will start a new
connection.

Move the mouse over U1 pin 2.

You’ll now see a finish indicator with a small solid circle on it. This indicates that the
connection can legally be finished here.
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R1 e -
LK % 3 + 1

You do not have to be exactly over a pin for the finish marker to be displayed, as long as the
cursor is within range then it will be shown.

Click the mouse button once to finish. You’ll notice that the component pin terminals X
disappear when you connect to it, this indicates that it is connected.

Following our ‘sketched’ design, complete the connections in the design.

» To join connections together

There are a couple of connections which must be connected together. Let’s assume that
you've made a connection and now you need to connect another to it using a junction dot.

When you move over the existing connection and hover momentarily, a finish marker will be
displayed. Click to release the connection here and this net is now connected to the one
already there. A junction dot will automatically be added to show the connections are
connected.

Complete the design adding the connections required.

Adding Power & Ground Symbols

Power and ground symbols are used in the Schematic to indicate a connection to a power
source. These symbols are required for aesthetic purposes and are not translated to the PCB
(because they do not have PCB footprints associated with them). The signals they represent
are connected together at the translate stage by ‘implied’ connectivity. The power & ground
symbols themselves can contain inherent net name properties that are automatically used
when the symbol is attached to the net.

oV
C4

0. 22uF
oV

» To add Power symbols

Click on the Add Component icon on the toolbar.

Add Component
Librany:
Schema v
Lompanent: | [ e B
:?\5\/ - Cancel
:;% [ Filker
B Apply
12y
A8 Clear
24y
&1
42
A3 Package: ]
&4
ANSI & Fef Mame: REF1
ANSIB
Preview |ANSIC v | [[]Addto Component Bin =~ 1

0 V REF1
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In the Library: drop down list, select the Schema library. Any selected symbols will be
previewed as being Schematic symbol with no PCB footprint.

In the Component: list select OV. You will see the symbol selected in the Preview box.
Ensure the Add to Component Bin check box is unchecked, click the Add button.

The 0V symbol is on the end of your cursor. Move it near to C4 and click the mouse once to

release it.
DY
4

i B.22uF

[RY
Using our working design, add two more 0V symbols, then click the Esc key to cancel. Select
the Add Component option again.

Our original design is shown below. Your component names may differ slightly, it doesn’t
matter, their relative position and values are more important.

HSV +isV
I ’ AD B4 AN
oX I IV
z I W ¢ -lg\/
oV Malex omedor
l0-lb-10%)
Voo

Add one +15V symbol and place near C3, then Esc again. Now add one -15V symbol, place
near C4. Click Esc to exit.

Drag a connection off the end of the symbols and connected as shown below. Move the power
gate for Ulb to the position shown below just under C4.

Your design will look something like this:

+15V

. 22uF

c3
2

Ula
ADB4 4 AN

1
| |
R2
11K

[
Il
c1
68n
R3
1. 6K

C4
@. 22uF

-15Vv

280n

Ulb
AD84 4 AN
o J_
V+

Generally speaking, you would now need to add some connector pins to connect the circuit to
the outside world.

g
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Adding Connectors

For this example, we will use an existing connector component from the library.

» To add Connector pins

Click on the Add Component option from the toolbar.

B Add Companent s
Library: Connector w
LComponent: (&g Find... Add
~ Cancel
[T Fiter
Apply
Clear
DaF
D15F
D1 Pt Nane:
DZ25F .
D26k w | [ &dd to Comparent Bin 1
]
Z
3
4
=
[

From the dialog, select the Library: Connector from the list. In the Component: list select
the SWP connector, this will be shown in the Preview window along with it’'s PCB Footprint.

Click the Add button to add it to the design, place it near the resistor R1. Click the Esc key to
cancel Add Component. If it comes in mirrored to what is shown here, mirror it back using
<F> Flip.

L3V

I
B. 22uF

c3

I
R3
1.6K

mOoO O M »
% 0]
zr
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[ P N
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i WT
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|
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11K
||
|
Cci1
68n
]

C4 15V c
8. 22uF &
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"
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Connect in the connector to the design using Add Connection or by dragging off pin. You
will also need to add another +15 component for completeness. Your design should look like
this below:
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Click the Save button on the File menu to save the design. If you are using the tutorial in
demo mode you cannot save it.

Naming Connections

One last task that is often required is that of nhaming connections in the design. We've added
‘normal’ connections which have been named using the default naming convention and have
been given ‘system’ names like NOOO5, NO100, NOO8 etc. We've also added connections
between pins and components that have pre-defined net names (power and ground
components, +5V, 0V etc.).

We now need to name a few connections to make them more specific for use in the PCB
design.

» To edit net names

Select the connection just off pin 7 of the Op-Amp’s power gate, the gate marked as U1b.

Right click and from the shortcut menu, select Change Net. If you use this a lot, you can
assign it to a shortcut key.

oot 1K ALMA_X
4

dlof— 1

EO_S |

FL1

SKP

Deselect

Select Mext M
Place

Change Style... 5
Edit Segment:

Arc 4

Display Met Mame

Change Net. ..

Highlight Met

AutoRoute

§ Paste Chrl+y

| Delete Delete

Qrigins 3

F&' Properties... Ale+Enter
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From the dialog now displayed, select the Net Name: +15V from the list.

From the Net Class: list, select Power. This will pre-assign you a set of connection properties
for this net when it gets used in the PCB portion of the design.

Change Net

Choosge From All Mets In Design:

Met Marme: (] 8

Cancel

Change Mame OF Subnet Only

Met Class: | Power

Ground

Signal

Click OK and return to the design.

If you wish to see the Net Name in the design, right click again with the connection selected
and choose Display Net Name from the menu (this is the option just above the previously
used Change Net option). The net name will now be displayed in the design, you may
reposition it if required by picking and dragging it.

Now select pin 4 on Ulb. Using Change Net again, this time select the net name -15V.
Select the Power Net Class again. Click OK to exit this dialog. The Net Name can be
displayed using the method above if required.

Translating the Schematic to PCB

The final process before starting on the PCB design itself is to translate the Schematic design
into the PCB design environment.

When you are in a position where you wish to go-ahead with this translation you should use
the Translate To PCB option from the Tools menu. This is discussed in the following pages
in the PCB Design section. Select this option now to carry on.

Translate ta PCE *

PCE D esign: @
Technology File:w - Folders..

Usge Component Bi

Carcel

Type in a PCB Design: name.
Leave the Component Library Directory as selected for you by the program.

Select a Technology File to be used for the PCB design. Use the Default.ptf technology.
This will give you a basic double-sided design.

Check the Use Component Bin box. Click OK to translate the components and netlist to a
PCB design.

The PCB design editor will run up. All of your PCB footprint components will be in the
Component Bin, the design will initially appear empty, don’t be alarmed this is normal!
Schematic Design Completed

You have now completed the first section of this introductory tutorial so let’'s move on. Leave
everything as it is and read on if you wish to continue with the PCB design tutorial.
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Chapter 3. PCB Design Editor

Getting Started with the Design

Easy-PC PCB is flexible in that you can start your layout in a number of ways:

e Use Easy-PC Schematic Capture as the 'front-end' to the PCB system. The nets and
components are translated to PCB in the integrated environment.

e Use a netlist that is derived from another CAE or Schematic system.

e  Use the Easy-PC PCB design editor interactively creating the design on-the-fly
without the need for an initial netlist. You just add connections and components as
required to create the PCB design.

Translate to PCB

We will take the ‘logical’ Schematic design created in the previous section and convert it to a
‘physical’ PCB layout.

You can skip this bit if you have already translated your design, go onto Setting up a PCB
Technology below. If you need to translate the Schematic to PCB - from in the Schematic
design editor with our tutorial design, select the Translate to PCB option from the Tools
menu.

Translate ta PCE *

PCE Design: @
Technology FiIe(lngay - Folders..

Usge Component Bin

Carcel

Type in a PCB Design: name - Tutorial (no file extension is required, just the name).
Leave the Component Library Directory: to the setting displayed.

Under Technology File, choose Default.ptf to be used for the PCB design. The Technology
predefines ‘rules’, such as the layers, pad styles, track styles, colours and other aspects of the
‘make-up’ of the overall PCB design. Technology files make the initial set-up of a design much
quicker but you can modify all aspects of this during the design stage.

Select the Use Components Bin box, we will put our components into an off-page location
for clarity for now.

Click OK to convert the components and netlist to a PCB design. Your design will appear
blank, all the components are ready to place in the Component bin which is not visible.

At this point you are ready to start laying out the PCB design.

Setting up a PCB Technology

When choosing or setting up a Technology file in your design you must think ahead and think
about the final manufacturing process and whether your manufacturer can handle it. The
technology used by you can have an impact on the cost of the final PCB. Changing your track
styles from 8 to 6 thou for example, or adding blind and buried vias could have significant
costs implications. You should always check that the boards can actually be manufactured.

All aspects of the technology can be edited and added to as you go, this includes the number
of layers in the design, styles and names etc.

For this exercise, you will use a pre-defined technology file, Default.ptf. This provides you
with a two-layer PCB with a set of general purpose styles and sizes. It also uses a black
background; this can be easily changed if you prefer a lighter colour background such as
white or light grey which seems to be easier on the eyes.
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Layers

The Easy-PC PCB design system supports an unlimited number of layers in any combination of
Electrical, Non-electrical, Wire, Construction and Documentation layers. These layers are used
to detail the physical 'make-up' of the manufactured PCB.

Below is an illustration of a typical 4 layer PCB showing the 4 electrical layers, 2 outer layers -
Top and Bottom and the inner power plane layers - Ground and Power.

Silkscreen Top
Solder Mask Top

I — Paszte Mask Top
Top
Grand
Povaver
Buattam

J m— ———————— Paste Mask Bottom
= Solder Mazk Bottam
Silkscreen Battom

Documentstion

If you wish to view the layers dialog, from the Settings menu select Layers. Click OK to
close the dialog once you've viewed it.

Creating a Board Outline Interactively

Board outlines can be created easily in Easy-PC; by adding board shapes (including circles) or
by importing DXF files from your mechanical system which contain board outlines.

Add Board allows you to interactively create a board outline by drawing it into the design.
Three shape styles are provided: Rectangle, Circle and Polygon.

» To insert a board outline

On the Add menu, click Board> Rectangle.
This is the shape you will create; the overall length is 1900 thou and the height is 1300 thou:

With Add Board selected, in the design area right click and select Type Coordinate from the
context menu. On the dialog, type 2000 X and 2000 Y, then click OK. This starts the shape.

Type Coordinate

NE O
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Now right click again and from the context menu, select Type Offset. On the dialog, type
1750 X and 1300 Y, then click OK.

Type Offset
¥: 1300 Cancel

Your board will look like this so far:

Click the mouse once to add the corner at the top right side.

Drag the corner down so that a 90-degree corner is formed and the remaining two sides are
straight. Double-click to finish.

3

Once a board outline has been added, it can be modified afterwards, extra segments added
and the corners can even be mitred or curved.

Add the *notch’ now. Double-click on the
right side to insert a corner. Move the
cursor right 150 thou and up 250 thou.
Single click to add the first corner.

Move the cursor up 800 thou. Single
click to add a corner.
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Move the cursor left so that the two
remaining floating segments are at right
angles to each other.

B Double-click to finish.

Our board outline is finished.

We now need to place the components in our design.

Using the Component Bin

While we've been starting the design with the board outline and preparing the technology, our
components have been sat in an off-design location waiting to be placed. During the
Translate To PCB stage, we checked the box on the dialog to place the components in the
Component Bin. There are other ways to work, such as placing unplaced components around
the board outline or placing them in a ‘pile’. We now need to open the Component Bin and
place the components in the design.

From the right side of the Easy-PC design edge (called the framework), you can hover your
cursor over the tab Component Bin

- o N
-8 X

X |3 %5 -

40000 | o= Component Bin T RX o
b b
@ s
& 5]
g 2
= . PL1 3
S When opened it S
E looks like this ek 5
2 ooks li i €2-C[D5C] 3
E C3-C[DSC 5

C4- C[DSC]

RT-R[DSC]
Kf R2-R([DSC] ®
Z R3-R[DSC] z
3 U1 - ADB44AN [DIPE] =
1)
= S
: g
(=]
B E

This will display the components we sent to the bin.
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» To drag Components from the bin

You can select a component from the Bin or the Preview window. To use a component, ‘drag
and drop’ it into the design (pick it and while picking, drag it into place).

Note: during place the drag may be cancelled by dropping the component back into the Bin,
by pressing the Esc key, or once released by using Undo (Ctrl-Z).

Once in the design the component can be moved until released, again by picking and
dragging.

Place all the components to look like the picture below. It is suggested you place PL1 and U1
first and place the other components around these. Placement on this design isn’t critical but
if you can improve on it, do it.

C4

1 F

i

.

—E-

|

Moving Components

Once the Components have been dragged from the bin you can place them in the design.
While placing components, use the shortcut key R to Rotate them and F to Flip (mirror)
surface mount components, these options (and more) are available on the shortcut menu
during Place by clicking the right mouse button.

Lk

Cancel Esc

Type Coordinate. .. =

Type Offset, ., Shift+=

!
Rotate >| v | Angle 0
Flip F Angle 90

Drynamic Optimise Chrl+D Angle 180
Show Design Clearance Angle 270
Online DRC

L]
C2
Rotate Cne Step R
Push Mode 3

Rotate Step Back  Al+R

Push Direction 3

Sprir k.

|
£

For our design, no mirroring (Flip) will be required. The placement and overall connection
lengths could be improved by rotating some of the components. If you feel you would like the
practice placing components, select a component and click R to rotate it. Component names
can be rotated back to be a readable direction separately using the same pick and rotate
method.

Once fully placed, the design should be routed.

Save the design at this point using the File menu | Save option.
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Routing the Design

The design can be routed manually or automatically. This is the process of converting the
electrical point-to-point connections into physical copper ‘tracks’.

Initially we will route the design manually. Easy-PC has a set of powerful manual routing tools
to aid this process. These tools allow you to swap layers, automatically add vias on layer

swaps and edit track thickness.

The routed board might look something like this (we’ve changed the colours to make the
design easier to view in this tutorial):

C4

1 H

gl

c2

=

R2

1 F

ma N ﬁjgma

PLL

» To start routing tracks manually

To start adding tracks, double-click on a connection, this is the quickest method to start
routing, other methods are available.

RB\

T T TN
0

Track Layer

0ld Layer: | Top Copper

New Layer | 2 Bottom Copper v

Wires
1 TUE CUEEer

Cancel

Hover the cursor over the connection to reveal
the design tooltip. This will tell you that you
have selected the correct connection.

If you followed our design placement loosely,
double-click the connection between R2 pin 2
and R3 pin 2.

Move the cursor to the right and up slightly.
You'll see the track starting to take shape and a
connection between the end of the track and the
‘target’ pad (R3.2). In this mode, the track is
placed orthogonally at 90 degrees with two
floating segments.

Click the mouse once, this places the first track
segment (the straight track segment coming out
of R2.2).

Click again to add the second corner.

Now we will add a track layer change.

Press the 'L’ key on the keyboard and the
Change Layer dialog is displayed. During
normal routing where a layer change from one
side to the other is required, a simple 'L’
followed by <Enter> is all that is required. The
Enter button is the same as clicking OK on the
dialog. In time you will be able to change layers
without looking at the dialog.
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P G G

I_'_I

A via has been added automatically and the
track layer is now on the Bottom side and is
shown in a different colour (blue).

Move the cursor right and click again. This will
either be the next corner or the next location for
a via for a layer change.

Press ‘L’ and <Enter> again to change layers
back to the Top layer. Another via is added
automatically. The via and track sizes are taken
from the net class, this is set up as part of your
Technology file.

Move the cursor up towards the target pad R3.3.
Notice how it is on the Top layer shown in Red.

Move the cursor (with track) over the target
pad. When a legal landing site is available, the
cursor changes to a finish marker, a highlighted
‘blob’.

Click once to finish the track editing for this
connection. After the track has been added, it
can always be modified afterwards by picking
and dragging the track or by double-clicking on
the track to edit it.

Move onto the next connection for editing.

Summary of the basic modes of routing

During track editing, the basic commands for use are:

e Single-Click, once editing, this will insert a corner to change routing direction.

. L followed by <Enter> will enable a layer change to the opposite side of the design.
This can be used during editing, or afterwards on selection of a track.

» To change manual routing modes

You would have been using the standard routing mode of Orthogonal routing (two ‘floating
segments at 90 degrees to each other).

| E—

R3

4 F

Cancel Esc

Finish Here

Track Layer... L
Track Style... E
Change Via Style. ..
Change Net...
Highlight Net

I_l_l

Disconnect Track End
AutoRoute

Start Track Hugging
Show Design Clearance

I Online DRC

Changs Segment 3

’

This mode can be changed by accessing
the routing mode during routing. Select
the Segment Mode> from the shortcut
menu and choose the mode from the
choice of five available.

[ seament Mode Y

Flip F

Invert Shape 1

Free

Orthagons!

Right-angle

Mitre:

Fillst

On our example design, the routing may
now look like this using the Mitre mode.
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Picking in tight areas

When attempting to select items within a dense area of the design or where multiple
connections cross each other for example, it is not always easy to pick the item required at
the first attempt. Under these circumstances Easy-PC has a system of picking that 'cycles’
through items adjacent to it until you select the item required. Once selected, an action may
be made on that item, Properties for example.

The shortcut keys used for the commands Select Next and Select Previous are set up as N
for Next and P for Previous, these can be changed if you wish to.

To try this, click on a pad that has a track attached to it, the pad (or track) is selected. Now
click N and the track (or pad) will be selected. Depending on how close it is to other design
items, the component outline and the whole component may also be selected at each click of
N is made.

Unrouting Tracks

You may sometimes have a requirement to unroute all or part of the design. Unrouting is the
process of removing tracks leaving only the connections remaining.

The Unroute Nets> option is available on the Tools menu, the three options available to
control the amount of unrouting to perform.

Try using the Unroute Nets> All Nets option to unroute the whole design removing all the
tracks already done. For the next tutorial section, we will use the autorouter to re-route the
design. Don't forget, once unrouted, you can always restore the routes using Undo (Ctrl-2).

Using the Autoroute Option

The Easy-Router autorouter option is available in the demonstration mode or if you have
purchased it. This is the entry level router that we supply, we also have the Pro-Router
available; this is a far more sophisticated autorouter. This can be evaluated in the demo mode
of Easy-PC if you haven't already purchased it.

The Autoroute option is used to convert your nets into electrical tracks as with manual routing
discussed previously. However, on dense designs it can save you many hours or days of work.
The autorouter can take an unrouted design and route it within minutes quite often.

You can use the autorouter in many modes; on All Nets in the design, on Browsed Nets,
Browsed Net Classes, on selected nets and on components.

» To use the autorouter

From the Tools menu under Auto Route Nets>, select All Nets.

We will leave the default settings as Simply click the Route button at the bottom of
they are: the dialog to start the router. This small design
will easily route 100%.
Trace Router
Load Riesults After Each Pass
Routing Passes Dizplay Report On Completion
50 = [Unrlimited
Claze Cancel
Tracks
[ Uze Mirirum 'width Keep Fized
[] ¥eep Prerout [IFixN . . .
o e i The results are displayed in a report, click OK to
Routing Style: |45 degree w . .
close the dialog and view the completed routes.
[ ] Optimising Passes []Fanout Passes
4 2 Unlirnited 4 2 Unliritzd
Route By Net Class Costs
Select Classes.. Defaul Costs

Load Results After Each Pass
Digplay Report On Completion

Close Cancel
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The routed design might look something like this below. This will vary depending on how you
placed the design.

C4 R1

1 H

Y]

Ut R3

PL1L

|

c2 R2

e |

P Save the design

The PCB design has already been named when you translated from Schematic to PCB, we
named it Tutorial.pcb. We named it this so it matches the name of the Schematic. This will
become more important later on when you run the integrity checks before plotting.

For now, click the Save icon on the toolbar or Save from the File menu.

Pouring Copper into areas

Copper Pour is used to flood areas of a PCB layout with copper, usually connected to a
nominated signal through ‘thermal’ connections, typically Ground (GND) or VCC. This facility
will then create voids around tracks, component pads, vias and other electrical obstacles.

For this we have the Add Copper Pour Area and Pour Copper options.

If a copper area is to be inserted without the need for voids around unconnected tracks,
components or pads, the Add Copper option can be used.

The principle of this facility is to insert a Copper Pour Area and ‘pour’ the copper into this
area.

» To create a Copper Pour Area

From the Add menu, select Add Copper Pour Area> Rectangle Other Pour Area options
are available for adding different shapes. We will add the pour area to the Top Copper layer,
pour areas and poured copper can be added to any electrical layer. To change layers, select
the pour area and click L followed by <Enter> as we did when editing tracks.

The shape can be created on the design and the Pour Area can be drawn protruding outside
the board outline. Easy-PC will pour the copper using the Spacing rules and rules defined for
the Pour area.

Following the picture below of our example, drawn in a basic rectangle pour area shape, this
is shown in black in the top left-hand side of the design:
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=
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FL1L
cz R2
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For this example you will see how easy it is to add a poured copper area.
Right click on the pour area.
From the shortcut menu select Pour Copper.

[Vl -

Previous Layer

Change Style... 5

(o3 Change Shape Type. ..
—D_ Add Carner

Edit Segment

-

Arc
|& Pour Copper

Add To MNet
Delet Delet
" W Delete elete
Qrigins 3 FL1
Cz
D H Grids...
[fﬁ Properties... I

A dialog is displayed from where you can select parameters for the poured area, such as the
net name association and thermal connections etc.

Paour Copper s
Het Marne: 5 :
154 ~ Cancel
-U'IVE\"' Min Copper Area
5881013 -2500 Sq. thou
MO014
Egggg |zolated |slands
Egg%g Y] Remove Highlight
Rulez
Item Type:  Spoke Type: |zolation: Relief: Hatch:  Spokes: Wi Fule From:
Thr. Pads:  Prefer Qrthogonal Spokes 100000 100000 Mo 4 2 Design
StD Pads:  Prefer Qrthogonal Spokes 100000 100000 Mo 4 2 Deszign
Wias: Prefer Orthogonal Spokes 10,0000 10,0000 No 4 2 Design

Areas to pour: 1

For this exercise, leave the Net Name blank and simply click OK.

Notice that the poured copper has obeyed the Spacing rules of all defined items to copper
including Board to Shape rules.

N\ ﬁ]am

R3

I

FL1L

cz R2

e F

» To remove poured copper from a copper pour area

To remove a poured copper area (including any thermal spokes), simply select the area
outline and select Clear Copper from the shortcut menu. This removes the copper but not
the Copper Pour area.
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Change Shape Type. ..

Mext __yer
Previous Layer

Change Style...

Add Corner

Edit Segment

Arc

& Pour Copper

|g Clear Copper

Add To Met

K| Delete Delete

Qrigins
Qrids. ..

Eﬁ Properties...

o e

When using poured copper remember you shouldn’t use Delete but should always use Clear
Copper. Copper Pour Areas can be modified at any time and the area re-poured using the
option from the shortcut menu. If you wish to completely remove the copper and area, you
must use Clear Copper first and then delete the area afterwards using the Delete key.

» To make the copper Pour Area intelligent

There are more facets to the poured copper than we have discussed above. The poured
copper can also have a net name associated with it so that when poured, pads are connected
via thermal spokes to the copper itself. To do this, select the pour area and from the shortcut
menu select Add To Net. Select the net name required from the list (try 0V) and then re-
pour the copper. Try it again using 0V as the net name and click OK.

Pour Copper

et Mame:

Using the Thermal Pads
check box and the Spokes
settings, the style of who the
copper is connected to pads
can be defined.

X

Cancel

bin Copper Area

2500 Sq. thou

Isolated |slands

Bemove Highlight

Rules

Item Type:  Spoke Type: |zolation: FRielief; Hatch: Spokes: Min: Rule From:
Thr. Pads:  Prefer Orthogonal Spokes 10,0000 100000 Mo 4 2 Design
SMD Pads:  Prefer Oithogonal Spokes 10,0000 100000 Mo 4 2 Design
Viag Prefer Orthogonal Spokes 10,0000 10,0000 Mo 4 2 Design
Areas to pour 1

Copper Pour Areas are not plotted and will not
appear on your plots, they provide the system with
an intelligent area into which the copper can be
poured.
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Adding Dimensions

Dimensions used for documenting the physical measurements of the PCB and can be added
using the Add Dimension option from the Add menu. This is used to display (in the form of
a dimension) lengths of items, radii of arcs and angles between lines.

1750 i

L9002 L

C4

R1

D3l

1304a
1905@
(B
PLL
c2 R2 ¥
250
Y /
All Units shown 1n thou *

» To insert dimensions

Select Add Vertical Dimension (Ctrl-J) from the toolbar.

Il.‘l»
2

Select the first point to start the leader line (the board
outline for example), then the second snap point which will
be the outer dimension limit.

Move your cursor away from the design so that the
dimension measurement text and leader lines can be
placed. Click the mouse to place the text. You can move
the lines afterwards to make adjustments. Aspects of the
dimensions (text, values, lines, arrows etc.) can be
customised to your own requirements using Defaults and
Properties of the dimension.

Checking the Design Integrity

The Integrity Check option is available in both the Schematic and PCB editors on the Tools
menu. This is used to compare and verify designs and make changes in the PCB so that they
are both in-sync with each other at all times.

» To check the designs

You can use the Integrity Check option from the Tools menu at any time. By default, the
file used for the comparison will be the same name as that used for the Schematic (or PCB
design if running from the Schematic editor).

When run, if there are no differences, the following dialog is displayed:

EPCWin

l G The designs are the same.

oK

If differences are found, Notepad will be run to view a detailed report. The report will give you
a list of changes that would have to be made to the PCB in order to make it match the
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schematic (the schematic always being the ‘master’). You can then perform these changes
automatically by selecting the Yes button on the dialog.

EPCWin

Differences found.

Forward design changes to PCB?

Run this option on our tutorial design, there should be no differences. If there are, click the
Yes button and make the changes.

» To back annotate name changes to the Schematic

Back annotation changes can be made in the PCB, these can also be passed back to the
schematic using the Back Annotation option from the Tools menu. When run, it will report
and allow you to perform any back annotation changes to the Schematic that are ‘pending’.

» To validate the electrical connectivity of the design

Another essential aspect to the overall design integrity check is the validation of full electrical
connectivity in the PCB design. You need to be sure that all connections have full electrical
paths between each point. This would include electrical paths through copper planes, vias,
plated and non-plated through-holes and through tracking.

Run the Connectivity Check from the Tools menu. This will display a dialog from which to
select what to check.

Connectivity Check

(®) Design Report
() Selection [ 0nly Errars

(] 8 Cancel

A report of all the connectivity is displayed. Any warnings or errors are reported and should
always be investigated. The full report above the summary explicitly lists these warnings and
errors so you can locate them.

Design Rules Checking

Before outputting your design for manufacture, you must run the Design Rules Check
option. This dialog contains check boxes that enable various checks to be made. The checks
are made against the Spacing rules defined. This is also used to check various manufacturing
rules have been obeyed.

When errors are found, Error Marker letters are added to the design on the appropriate layer
to help you find and correct the actual error.
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» To run a Design Rules Check

Select the Design Rule Check option from the toolbar.

Design Rule Check

Spacing
Tracks
Pads + Vias
Shapes

Board
Dirills
Companents

[ Hets
[ Met Completion
[ Dangling Tracks
[ Track Lengths
[]with Na Comps
[[10n No Connect Pins
[ Single Pin

Checking Sets

Mormal | Load

Save

[ Marufacturing
Acid Traps
[ Componert &rea
[7] Component Height
[] Component Mames
[] Copper Shape Verification
[] Copper Text Outside Board
[ Dvill Breakout
[ Dvill Backaff
[ Inner Tracks on Unplated Pads
[ Min Asnnular Ring
Only ‘where Track Exists
[ Mir Drill Hole Size
[] Min Paste Size
[ Min Text Size
[ Min Track Meck Length
[ Min Track Wwidth
[] Mirrored Text
[ Modified Paur Areas

Silkscreen Overlap

[ Shapes [ Board

[ Text [ Pads
[¥ias
[ Free Pads
[ Text

Raouting Areas

[ Stub Viasz

[ Test Land Separation

[ Test Land Size

[ Test Land Under Companent
[ Test Land Unreachable

[ Undrilled T hrough Pads

[ Unplated Wias

[ Unpoured Areas

[ Vias In Pads

[]via to SMD Pad

[wdires

[] Other Checks

Sigr-aff Load Save

[ Integrity Check

(®) Whole Design

() Only Selection

() Inside Board Outlines

() Inside Selected Board

() Inside Mamed Area:
BGA

Repart
Detailed Report

Settings
] Check Test Shapes

Existing Emrors

Delete &l Emors
Drelete Mormal Errors

Delete Accepted Erors

Aiccept Existing Enors

X

Cancel

Help

A dialog is displayed that allows you to control which items are included in the check.

A minimum check would be for Spacings but other checks can be made as required.

Click Check to run the DRC.

» To locate DRC error markers

After running a design rules check, you can find the error markers in the design using the

Goto browser.

This is available by right-clicking the
mouse with the cursor positioned over
the Easy-PC framework (the area
around the design or over one of the
menu items or toolbar icons).

Select the Goto option from the menu list.

When the Goto browser is displayed, from the list
of available Goto options, drop the list down and
select Errors.

w x
- o x Goto 2 X |8
m— Erar vl
+ | PCE Design -gx Component 2
LC|] - @
' | File Cornponert By Package) @
) 1 4 v | Edit 0 || Component (By Symbol)
7 view ~ 5 Component [By Type]
= T Component By Walue Content
(2] Tools @ Companent [By Walue Name] ﬂ
[v] MenuBar ‘% CDDDE_J Pour Area i
= = Danaling Track =]
L] Status Bar = Design _E
% World Vi g 5
arl lew 3
2 Group z
% Add Component 2 Hale Size =4
ﬂ Component Bin Ctrl=F9 3
G2 layers
B ColourFiles lg‘
M Goto %
[L-_ Shape Information
EE
L Mets
i
Motes 2
o
a Properties =
3= o
@
= Toolbars...
S Ruler Settings...
1:@: Customise...

1A U8 U000 2 [l
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Goto < bt

< | %
s1adET é%

Error
FPad to Board [P-B] -
[l
(10073, 26223)

(10743, 26208)
(11023, 26183)
(11023, 26253)
(11323, 26183)
(11423, 26253)

Padto Pad [P-P)

[&l]
(10743, 25798)
(10743, 25898)
(10743, 25395) &

ulg uauodwon [y

Reports, Part Lists and Net Lists

Easy-PC can generate reports where all vital aspects of the design can be reported in detail. A
set of ‘standard’ reports like Parts lists and bill of materials (BOMs) are supplied as well as the
ability to generate User defined Parts lists and Netlists using the Custom Reports option. All

reports are all available on the Output menu.

15 | Output | Tools Window Help
L ||Z Reports...

E BOM Composer...

el

[G}  Plotting and Printing...
CXE| DXF...

IDF Version 2.,

IDF Wersion 3.

IDE
& pc2ssi..
&

5 ODB+=..

Metlist

R
L
|
Ctrl+P [—

"' Reports

Builtin Reports
Assodated Parts
Component Height
Connectivity Check
Copper Coverage
Dangling Tracks
Design Rule Check Report
Design Status Report
Differential Pair Report
Generic Metlist
Integrity Check
IPC356 Testand Output
IPC3564A Testland Full Output
Layers Report
Net Completion
No Connect Pins
Pad Style Exceptions Repart
Parts List
Shartout Keys
Source Library Report
Stoddt Parts List
Testland Report
Thermal Rules
Track Analysis
Track Length Rules
Unconnected Pins Report
Variants Report
Wires
\Wiring List

BOM Composer Reports
Bill of Materials

User Reports
Bill Of Materials CSV
Bill Of Materials
BOM With Names
Component Positions CSV
Component Positions
Mets Table
Pad Positions CSY
Simple Netlist

This list is used to view all the design error markers as a sorted list.
It is displayed in an 'active' browser. You can use a double click of
the mouse to select an error by name in the browser and then the
error marker in the design. The error marker will be brought into the
(10373, 26228) centre of the display so it can be seen, checked and cleared.

During your testing of the options, run the
reports option to see what they can produce
for you. Each report will be displayed using
Notepad, close the report once viewed.

Easy-PC can produce some useful design
verification reports for checking the
Connectivity, Design Integrity, Net
Completion as well as Pick & Place and
Testland outputs.

You'll see on the list plenty of ‘general’
reports plus User Reports that can be
created and customized by you to your own
requirements.
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Plotting the Design

Easy-PC provides you with an output mechanism for generating professional PCB layout plots
for manufacturing. All the plot and drilling outputs are located in one easy-to-use dialog.

From the Printing & Plotting option on the Output menu, you can output all types of plots.
You can select the layer or combinations of layers to plot. You can also set the scale, rotation,
the position on the plot and the plotter type. All plots and outputs can be delivered in one
button press once set up.

Plotter types available are:

Gerber 274-D, 274-X (extended Gerber format) and Gerber X2 format photo-plots
Numerically controlled drilling (NC Drill) information

Windows printer plots using any installed Windows driver

HPGL Pen Plots

Standard and customised reports

ODB++ format files

IPC-2581 format files

Active PDF files

Plot types

Plots are available for all aspects of the design but because Easy-PC uses a configurable
output mechanism, it means that almost any plot required can be generated:

Top, bottom and inner electrical signal layers

Silk screen layers

Solder resist plots

Solder paste masks

Copper and power plane (full or split) layers

Assembly and manufacturing drawings

Drill ident/symbol drawings

NC Drilling files

Easy-PC can also output to DXF and IDF formats but these are not generated as part of the
Printing & Plotting mechanism.

» To output plots

Click on the Printing & Plotting option on the Output menu.

When you first enter this dialog, Easy-PC automatically creates you a set of plots based on the
layers in the design. These can be edited and amended at any time. Plots defined and
customised can be saved for reuse using the Save Job button.

Plotting & Printing

New Job... Open Job... Save Job Save As... Run
Plat Job: Close
Description: Options...

Add Plat Copy Plot Delete Plat Reposition Step & Repeat LI Piot Preview

Sign-off Checks
Output | Layers | Settings | Position
| Top Copper
| Top Copper {Resist) " . '
7| Top Copper (Pasts) Settings for plot: Top Silk
Bottom Copper = = =
|Battom Copper (Resist) (@ Gerber () Penplot () Windows Excellon () PDF | Device Setup...

| Bottom Copper (Paste)
Dimensions
| Drill Data - Through Hole Plot Name: | Tap Silk
| Drill Ident Drawing - Through Hole
Plot Type Atwork v

Output To: File ]
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The dialog itself is split into four main sections for saving the plot settings, defining the rules
of the plot, setting up the plotter type and device options.

The top part of the dialog is used to save plot jobs if you customise your plots (like plotting
Top Silk and Assembly together for example). You can use this to recall existing plot jobs to
other designs:

Plotting & Printing

New Job... Open Job... Save Job Save fs... Run
Flot Job: Close
Description: Options...

The left side of the dialog is the plot to be output. This is automatically named the same as
the layer but can be user-defined and edited by you. The check box indicates whether that
plot/layer will be plotted when Run is pressed.

Output | Layers | Settings | Position

| Top Copper

| Top Copper (Resist)

«|Top Copper (Faste)
Bottom Copper

Settings for plot: Top Silk

7| Bottom Copper (Resist) ® Gerber () Penplot () Windows Excellon  (JJPDF | Device Setup...
«|Bottom Copper (Paste)
Dimensions
| Drill Data - Through Hole Plot Name: Top Silk
| Drill Ident Drawing - Through Hole
Plot Type Atwork v
Output To: File v

The tabbed portion of this dialog defines the plotter type used for the selected plot/layer. Each
tab defines different properties of the plot, like the type, the layers included in that plot, the
settings (powerplane settings, thermal sizes, pad under/oversize for solder masks etc.) and
the position of the plot on the paper/film.

Output | Layers | Settings | Position
Settings for plot: Top Sillke
(® Gerber () Penplot () Windows Excellon  (C)PDF | Device Setup...

Plot Name: Top Silk

Plat Type: Artwork W
Output To: File v

The Options button and Device Setup button allow you to change the settings of the
selected plotter type. For example, changing from RS-274-D to 274-X format for Gerber.

The Options button also allows you to define which folder the plots will be plotted to.

Plotting & Printing

New Job. Open Job... Save Job Save As... Run
Plot Job: Close
Description: ( Options... >

Add Plot... Copy Plot Delete Flot Reposttion... Step & Repeat... BRI
Sign-off Checks
T‘?‘ =5 Outpt | Layers | Settings | Posttion
Gerber Setup —
Flatting Area General Commands and Options i ‘
From: |0.000 .00 Hardware Ares (G74. G75)
To [38.000 26000 Hardware Fill (G36, G37) Cancel

[Include D02 (Mave] before DO3 (Flash]
] Rotate Aperture Macros Clockwise

inches

Farmat
Integer. |2 Bt Additional Commands
[A Apertures AD AN
[] Dutput in Metric Urits (mm) Fomat Setting -
Mode [urits) MO
Scale Compensation %2
%1 e 1 [[]%2 File Function TF.FilsFunction

]2 Aperture Function  TF.ApeFunction
[]%2 Part Command TF.Pat
Include 2 commands in GO4 comments

Filename Extensions

® Al same extension:  [.gbr
() Extension by laper/type  Setup

“warn About Small Apertures 2 R5-274-% RS-274-D

Size: 0000 (0=Don't Check]

Click the Run button to output all the selected plots.
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Concluding The Tutorial

This concludes the tutorial. As we said above, it's a quick run through to give you an idea of
the flow of the Easy-PC product and how easy it is to use.

If you would like more information about Easy-PC, please contact our sales office or visit our
web site www.numberone.com

Number One Systems
20 Miller Court

Severn Drive
Tewkesbury

Glos GL20 8DN

UK

Phone: 01684 296 501
Email: info@numberone.com

Technical support: 01480 382 538
Email: support@numberone.com




